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Additional Information for Low-Power Consumption
Design
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Jingquan Zhu
ABSTRACT

TIDA-010224 is designed as a reference for low-power Wi-Fi® cameras capable of operating from battery
supplies. In order to extend battery lifetime as much as possible, most sockets are chosen to have a shutdown
current in the nA range (as shown in Figure 1-1) and the TPS63802 high-efficiency buck-boost is used. In order
to better understand more easily evaluate TIDA-010224, this application note describes a few additional use
cases, how to set up the compiler environment if code changes are needed, how to update the firmware of
CC3235 and OA7000, and how to test these use cases.
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Figure 1-1. TIDA-010224 Hardware Design Structure
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Introduction

1 Introduction

Below are additional test cases demonstrating the design's low power consumption. In some cases build of
material (BOM) and firmware changes are required.

Adding test cases:

» Testing current in hibernate mode
» Testing current in LPDS mode

» Testing average current under Intermittently connecting mode (sending 100 data to server)
» Testing average current under always connecting mode (sending 100 data to server)
+ Test key step time when startup (via universal asynchronous receiver/transmitter (UART) printing or signal of

connector)

» Evaluate performance of video and audio

Test case Features:

* The system can be put in wakeup from both Hibernate and LPDS mode via general-purpose input/output

(GPIO) or real-time clock (RTC).

* The current in hibernate mode is around 20 pA/5 V.

* The current in LPDS mode is around 120 pA/5 V.

« Startup time from hibernate to full running is less than 500 ms.
» Configurable interval time in intermittently connecting mode or always connecting mode
» Configurable stream transferring of only video, video and audio, video and ring

2 Hardware BOM and Firmware Modification

In order to reduce leakage current as much as possible, there are some necessary changes to implement.

* Hardware bill of material (BOM) changes
Table 2-1. Table 1. BOM Changing of TIDA-010224

Change Position Note
Delete CC1352 EVM board In these test cases, no Sub-1 GHz
connection.

Delete R116, R137, R91, R152, R118, R35-R40,
R127, R128

Change Net float U4.5 pin

Change Net Exchange resistor on R159 and R160 Make CC3235 can control
position

» Firmware changes
Table 2-2.

Table 2. Firmware Changing of TIDA-010224

Add Function

Detail

Hibernate mode

connected.
* Be wakeup by any of UART input.

wakeup.

« Enter Hibernate mode via UART input '1".
+  Choose which audio from, no audio/from microphone/from ring music after RTSP

« Ifthere is not a saved AP list in site, enter provisioning mode after it is in wakeup.
« Ifthere is a saved AP, connect with AP and prepare accepting RTSP connection after

SWRA759 — NOVEMBER 2022
Submit Document Feedback

TIDA-010224 3

Additional Information for Low-Power Consumption Design

Copyright © 2022 Texas Instruments Incorporated


https://www.ti.com
https://www.ti.com/lit/pdf/SWRA759
https://www.ti.com/feedbackform/techdocfeedback?litnum=SWRA759&partnum=

13 TEXAS

INSTRUMENTS
Firmware Compiler Environment Setup (if change or evaluate code are needed) www.ti.com
Table 2-2. Table 2. Firmware Changing of TIDA-010224 (continued)
Add Function Detail
Intermittently Connected mode +  Enter Intermittently mode via UART input '2'.
*  Choose which audio from, no audio/from microphone/from ring music after RTSP
connected.

» Define remote TCP server IP address.

* Define interval wakeup time from hibernate.

*  Output 100 data to remote TCP server after wakeup.

*  Wakeup by any UART input when it is in hibernate.

»  Enter accepting RTSP connection mode after wakeup by GPIO (UART input)

Always Connected with Long Sleep mode/with |« Enter always connected mode via UART input '3' or ‘4’.

10T mode » Define beacon time of connecting with AP.

*  Choose which audio from, no audio/from microphone/from ring music after RTSP

connected.

+ Define remote TCP server IP address.

+ Define interval time of sending data to TCP server.

+ Send out 100 data to remote TCP server after wakeup from LPDS mode by RTC.

*  Wakeup by any UART input when it is in LPDS.

» Enter accepting RTSP connection mode after wakeup by GPIO (UART input).
Measure Time of Key action mode «  Enter measure time mode via UART input '5’.

» Define remote TCP server IP address.
+ Send 10 pages image data to TCP server after triggered by any UART input.
»  Print timestamp of key action, same time, output HW signal via CC3235 GPIO_06 pin.

3 Firmware Compiler Environment Setup (if change or evaluate code are needed)

3.1 Hardware and Software Prepared
Device

* TIDA-010224 demo board
« (CC3235 Launch EVM

- PC

e 2x microUSB cable

Firmware compiled based on

» Code Composer Studio™ (CCS) Version: 11.1.0.00011
« Simplelink™ CC32xx SDK Version :5.30.00.08

» sysconfig tool Version: 1.11.0

* FreeRTOSv202107.00

3.2 Hardware Connection

1. Short J11.3 and J11.4 with a jumper in order to enable download function via UART.
J11

-3 @

-9 ©
-9 ©

2 SI0
4 Sl
6 Sl2

W |

Figure 3-1. J11 Connector
2. Connect J13 to CC3235EVM board UART pin according to the Connections Between CC32xx LaunchPad™
and Wireless Camera Module (J13 Connector) figure in the Design Guide: TIDA-010224 Low-Power
Wireless Camera Reference Design for Extended Battery Life.
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3. Connect J5 to CC3235EVM board’s J7(XDS10 OUT) connector with a JTAG cable.

Firmware Compiler Environment Setup (if change or evaluate code are needed)

J13 Debug conn

Figure 3-2. PCB Connector
4. Connect the PC to the camera board and the CC3235EVM board with the 2x USB cable. Power on these

two boards.
3.3 CCS Environment Configuration

1. Unzip FreeRTOS™ package (download from freertos.org) in a folder, and add variable in dialog from CCS-
>Window->Preferences->Code Compose Studio->Build->Variables.

Variable name: FREERTOS_INSTALL_DIR
Value: C:\ti\FreeRTOSv202107.00 (unzip folder address)

&P Preferences 0 X
text Variables ik
General
v Code Composer Studio Nome Type Yalue Add..
Adisincad Tooks FREERTOS INSTALL DIR  String CAti\FreeRTOSv202107.00
v Build
Compilers
Environment
Variables impor
Debug Export..
Grace
Products
Help
Install/Update
Run/Debug
Terminal
Version Control (Team) [] show system variables
Restore Defauilts Apply
? 3 &l Show advanced settings Cancel
Figure 3-3. FreeRTOS Variable Dialog in CCS
TIDA-010224
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2. Install Simplelink CC32xx SDK and the sysconfig tool (download from Tl.com). Refresh product in dialog
from CCS->Window->Preferences-> Code Compose Studio->Products.

88 Preferences O b4
type filter text Products i
General Product discovery path:
v Code Composer Studio —
Advanced Tools MISC/M/oc1110 it
v Build M OCAi
Compilers [ =3 C/Program Files/Texas Instruments
Environment
Vanables
Debug
Grace D:scoim_r_e.d productsf' ] .
Products ~ mk Simplelink CC13x0 SOK Refresh
Help = 4.10.1.01 k.4 1
Install/Update ~ m\ SimpleLink CC13x2 26x2 SDK Install...
Run/Debug o 520052 ‘
Terminal v B SimpleLink CC32xx SDK
Version Control (Team) ' 5.300.08
= 4.30.0.06
v m SysConfig
= 1110
v m XDCtools
' 3.62.1.16_core
= 3.62.1.15_core
= 3.61.2.27_core
' 3.51.3.28_core
E Search for products each time Code Composer Studio starts (may affect start-up time)
Restore Defaults Apply

- an - a

Figure 3-4. Installed Products Dialog in CCS
3. Open Workspace in CCS.

If there is no available workspace when CCS is started, a dialog will pop up to ask to select a directory as
workspace. Browse to the unzipped CC3235 Firmware folder and click ‘Launch’.

If a workspace in CCS is already opened, browse to the unzipped CC3235 Firmware folder in dialog from
CCS->File->Switch Workspace->Other, and click ‘Launch’.

8P Code Composer Studio Launcher X 1

Select a directory as workspace

Code Composer Studio uses the workspace directory to store its preferences and development artifacts.

Workspace: | CAWIFI_OV_Camera_FreeRTOS "

[:] Use this as the default and do not ask again

Launch Cancel
Figure 3-5. Launch Project in CCS
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Upgrade Firmware of CC3235 and OA7000

4 Upgrade Firmware of CC3235 and OA7000

4.1 Prepared Components
Device

« TIDA-010224 demo board

* USB to UART (3.3 V TTL) or CC32xx Launch EVM
- PC

* 5V microUSB Power and 2x microUSB cable

Software

¢ Uniflash from TI
« Serial assist tool
*  mftfw_tools from Omnivisioin

4.2 Upgrade CC3235 Firmware

1. Make SOP(J11) jumper to short J11.3 and J11.4 as shown in shown in Figure 3-1.

2. Serial port connection:
a. Plug USB2Uart in PC.

b. Connect USB2Uart (TTL) pin to TIDA-010224 board J13.

i. If using the universal USB to 3.3V TTL tool, connect J13.3(TX), J13.5(RX) and J13.9(GND).

ii. Ifusing the CC32xx EVM, connect the pin according to the Connections Between CC32xx
LaunchPad™ and Wireless Camera Module (J13 Connector) figure in the Design Guide:
TIDA-010224 Low-Power Wireless Camera Reference Design for Extended Battery Life.

Debug Connector

V3P3 MCU
J13
R151,-0 1 [ ol2 DEBUG NWP
UART TX ' 3 o elt DEBUG MAC
UART RX 5 o @]t KEY1
WIFI nRESET 7 o9 ol-2t KEY?2
9 e o 10 WIFI CONFIG
_l_
GND

Figure 4-1. J13 Connector
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3. Power up:
a. Connect USB power input of board to PC or USB adapter with microUSB cable.

USB Power inputl st
%

TSV DC Power input

Figure 4-2. PCB USB/5 V Power Input Connector and SW3 Connector

4. Open Uniflash, select as below.
3 uniFissh - g X

UniFlash  Session =  About @ Help O Semings

~ Detected Devices

Stalus o Active - Mositoring for chang: stting Aute -

Device: LAUNCHXL-CCI2355F (Dual Band 2.40Mz and 50Hz)

Sorial Nu

~ New Configuration
@ Selected Dovice ’ LAUNCHXL-CC32385F (LaunchPad)

Category: All | C2000 | mmWave | MSF | PGA | Safety | Tiva | UCD | Wiraless | Bactloads

1

p—

—

Pl

Start Image Creator

~ Creale Session From Existing Target Configuration File

Figure 4-3. Uniflash Startup Page
a. Input CC3235.
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b. Select LAUNCHXL-CC3235SF.
c. Click ‘Start Image Creator’ button.

] Simieiink™ image Creator o % ‘
UniFlash
3 TEXAS INSTRUMENTS Welcome to SimpleLink™

Wi-Fi® Image Creator

Program Image

Figure 4-4. Uniflash Image Creator Setting Page 1
d. Click and Create a new project.

[ simotelink™ imags Cranter - o X

UniFlash

Start new project

Figure 4-5. Uniflash Image Creator Setting Page 2

e. Input project name.
f. Select CC3235SF.

SWRA759 — NOVEMBER 2022 TIDA-010224 9
Submit Document Feedback Additional Information for Low-Power Consumption Design

Copyright © 2022 Texas Instruments Incorporated


https://www.ti.com
https://www.ti.com/lit/pdf/SWRA759
https://www.ti.com/feedbackform/techdocfeedback?litnum=SWRA759&partnum=

13 TEXAS

INSTRUMENTS
Upgrade Firmware of CC3235 and OA7000 www.ti.com
g. Select Develop mode.
‘ll Simplelink™ Image Cragtor =
UniFlash
&) TExas INSTRUMENTS Development Mode - Simple View o
— P
B =
Start Role. 9 " p B Back
13
o
} o m a 1

Figure 4-6. Uniflash Image Creator Setting Page 3

Select ‘Station’.

. Browse and select ‘WIFI_Current.bin’.

k. Browse and select ‘'sp_4.12.0.1_3.7.0.1_3.1.0.26.bin’ to install CC32xx SDK. It is located in
“ti\simplelink_cc32xx_sdk 5 30 _00_08\tools\cc32xx_tools\servicepack-cc3x35”.

I.  Click to connect PC to board.

m. Click ‘Burn’ to create the image and burn.

h. Click to create.
i
J

[ Simpielink™ Image Creator - o x
i3 TEXAS INSTRUMENTS Development Mode - Generate Image — c ‘
14 % Commetm
_— * Device Type: CCIZISST, Seeur |
- [ —— ® M 0 4 |
B HW Version: 46 ]
L1, T form Current Mod: P
£, Tl format, r
8 Available for User Files: 1154KE
] ocurnity Ale
hex —
B Back.

Figure 4-7. Uniflash Image Creator Setting Page 4
n. Click 'Program image' button.
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Simplelink™ image Creator

- (=} X
UniFlash

Figure 4-8. Uniflash Image Creator Setting Page 5
4.3 Upgrade OA7000 Firmware
1. Make SW3 jumper to “100'.
Boot mode selection

Boot [2..0]
000: SPI NOR FLASH (master mode) Default
001: SCIF
010: UART1
011: SIF2 (slave mode)
100: USB
VIPS OV
| R55 —_— R98
A 1 [ T v AMA | 1 GND
1.00k 1 100k |I|
VIP$ OV
R57 ‘swﬁj R97 |
5 BOOT1
oS 1GND
1.00k | Bl 100k |II
Cvs-0318
VIPS OV
1 R56 — R96
3 - 4 BOOTD AAA | |IGND
1.00k | I | 100k l]
CVs-03TB

Figure 4-9. SW3 Boot-Mode Selection

2. Connect the microUSB cable to the PC and camera board.

3. Connect the USB2Uart tool to the PC and camera board serial port as described in Section 4.2.

4. Open the serial assist tool in the PC, and open the COMx port with “115200, 8 bit, None parity, 1 Stop bit,
None handshaking’.

5. Power up camera board via ‘USB power input’.

6. Input ‘1’ for hibernate.

7. Input ‘1’ for only video.

8.

Input any to wakeup camera board from hibernate and power on OA7000.

Note
Because OA7000 power is controlled by CC3235, first, you need power on OA7000.
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9. Open MFT.exe in mftfw_tools, select as shown in Figure 4-10.
@ Select mft*.bin X | @ Select prj_cfg.txt X
A < || Tl Driver code (Ring IR board) || OV7000 Firmware || OV7000 Firmware | Latest | release | mftfw_tools » :/‘ 4 || Tl Driver code (Ring IR board) || OV7000 Firmware || OV7000 Firmware || Latest || release M 3
Places Name  Size Modified Places Name ~ Size  Modified
\ Search . gtk 8/19/2021 \ Search = gtk 8/19/2021
® Recently Used B lib 8/19/2021 ® Recently Used 5 lib 8/19/2021
5 20492322 [ miftfw 8/19/2021 B 20492322 5 mftfw 8/19/2021
2 Desktop [ output 8/19/2021 B Desktop 5 output 8/19/2021
< Windows (C) [ winush_driver 8/19/2021 < Windows (C) [ winusb_driver 8/19/2021
dump.bin 12KB 8/19/2021 pri_cfg.rd7000s.txt 34KB 8/19/2021
mft_bootloader.bin 68.3KB  8/19/2021
mft_bootloader-before.bin 67.3KB  8/19/2021
rom.usbboot.51806.bin 256.0KB  8/19/2021
up_rom.bin 100 bytes 8/19/2021
- L

Figure 4-10. MFT Tool Setting Page 1
10. Double click ‘mftfw’->0a7000s->mftfw.bin in ‘Select mft*.bin’ dialog. Then a new dialog window pops up

named ‘Select prj_cfg.txt’.

11. Double click ‘prj_cfg.rd7000s.txt’. It returns the main dialog named ‘OA7000 MFTxxxxx'.

@ OA7000 MFTV1.82575.16764
Edif

Help

(BumFirmware |Q Calibration  FuncTest ~ MCU Test

Burn Firmware

BURN SINGBIN

BURN MCU

Write UID

Read UID

Connected

GET SINGBIN VERSION

GET MCU VERSION

(m]

b4 . Select Single Bin File X
7 4 \| Work | 06 Common Technology | 02Tl Demo Board | TIDA-010224 Wireless camera design »
Places Name ~ Size  Modified
\ Search [£) Debug 3/31/2022
® Recently Used [ FW files 12/28/2021
B a0492322 [ HW Design files 5/16/2022
B> Desktop £ Presentation 171472022
< Windows (C:) [= Software enviroment 9/2/2021
5 SPEC 2/9/2022
[Z5 T Driver code (Ring IR board) 1172972021
R SINGLEBIN 25MB 4/27/2022
-

Figure 4-11. MFT Tool Setting Page 2
12. In this dialog, it shows ‘Connected’. Click the ‘BURN SINGBIN’ button.
13. Find ‘SINGLE.BIN’ and double click it. bin file burns to OA7000.
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@ OA7000 MFTV1.82575.16764 - ] X | @ OA7000 MFTV1.82575.16764 - m] X
Edit Help Edit Help
Burn Firmware  |Q Calibration Func Test MCU Test Burn Firmware 1Q Calibration Func Test MCU Test
H 0,
Burning...23% Done
. BURNSINGBIN GET SINGBIN VERSION . BURNSINGBIN | GET SINGBIN VERSION
BURN MCU GET MCU VERSION BURN MCU GET MCU VERSION
Write UID Write UID
Read UID Read UID
Connected Connected

Figure 4-12. MFT Tool Setting Page 3
5 How to Test Current and Startup Time

5.1 Prepared Components
Device

* TIDA-010224 demo board
* USB to UART (3.3 V TTL) or CC32xx Launch EVM

< WIFI AP
« PC
¢ Cell Phone

* 5V microUSB Power and cable
» Current meter or DC analyzer (optional)

Software

« Serial assist tool

* Net assist tool

» Network Stream video player (EasyPlayer for RTSP or something like this)

» SimpleLink Wi-Fi® Starter Pro APK (download from google store or Apple APP store)

5.2 Setup Test Environment

1. Power connection:
a. |If testing current, Power on from 5 V DC terminal. If only testing functions, USB power input connector is
also OK.
2. Serial port connection:
a. Plug USB2Uart in PC.
b. Connect USB2Uart(TTL) pin to TIDA-010224 board J13 as shown in Figure 3-1.
i. If selecting universal USB to 3.3 V TTL tool, connect J13.3(TX), J13.5(RX) and J13.9(GND).
ii. If selecting CC32xx EVM, connect the pin as shown in the Connections Between CC32xx
LaunchPad™ and Wireless Camera Module (J13 Connector) figure in the Design Guide:
TIDA-010224 Low-Power Wireless Camera Reference Design for Extended Battery Life.
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3. Setup serial assist tool:
a. Open the related USB2Uart port before the following settings:
i. Baud rate: 115200
ii. Data bits: 8
iii. Parity: none
iv. Stop bit: 1
v. Handshaking: none
vi. Sending: + CR(Enter key)
4. Setup net assist tool:
a. PC connect with AP. Open the TCP server before the following settings:
i. IP address: PC host IP
ii. Host port: 5001
iii. Receive: HEX

Note
Close VPN if opened.

5.3 Start Testing

Power on the TIDA-010224 board. The serial tool receives a message as shown in Figure 5-1.

startup Tick = 0 s: 0 ms.
the first start
#%% Choose demo working mode : #*#%
1) for Hibernate.
2) for Intermittently Connected.
3) for Always Connected with Long Sleep
4) for Always Connected with IOT mode
5) for measure Time of Key action
Please enter your use case selection:

Figure 5-1. Board UART Output Start Page

1. Provisioning mode.

If there is no Wi-Fi AP connected, selecting ‘1’ makes the board enter into Hibernate (provisioning) mode for
configuring AP SSID and Password into the demo board. Details are:

a. Input ‘1’ makes the board enter hibernate.
b. Select the video and which audio to use. It is preparing to play the video after wake-up from hibernate by
the UART input. After the input is finished, the board enters into hibernate.

Select Audio source when transfer video stream
1) only video

2) Audio from inside ring data

3) Audio from micphone

Please select audio type:

Entering Hibernate

Entering HIB

Figure 5-2. Select Video Stream Type via UART
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c. Input ‘1’ again, wake up board for provisioning, as shown in Figure 5-3.

Provisioning Start Ver. 01.01.00.00

CHIP 823132185

MAC 31.3.7.0.1

PHY 3.1.0.26

NwP 4.12.0.1

ROM 8738

HOST 3.0.1.71

MAC address: 90:e2:2:27:d7:33

starting Provisioning! mode=2 (0-AP, 1-SC, 2-AP+SC, 3-AP+SC+WAC)

Figure 5-3. Provisioning Status Output via UART
d. Open “SimpleLink Wi-Fi Starter Pro” APP in cell phone.

Configuration Page

Configuration Page

Select Device to Configure

Device to configure n D Device to configure ﬂ mysimplelink-270733
T mysimplelink-270733 8"

Name your device a

WiFi network a Peter
I Network password []erenenes

START CONFIGURATION

Name your device a

Show all

= = &

Provisiening D

= &

Frovisaning

Configuration Page
Select your Wi-Fi router from the list

Device to configure Q mysimplelink-27D733  +

’% Peter

Name your device
Show all

WiFi network g Peter v

Network password ﬂ D """" Provisioning Successful

@ Security Ke [:] START CONFIGURATION

Show 2.4Ghz Only D

_c |

Figure 5-4. “SimpleLink Wi-Fi Starter Pro” Configuration Processing
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e.
f.
g.
h.
i.

j-

Click the ‘blue marked’ button.

Select ‘mysimplexxx’.

Select your Wi-Fi AP.

Input password.

Click the ‘start configuration’ button and select ‘close’ to finish provisioning. UART print as shown in

Figure 5-5. Provisioning IP Address Acquired

After provisioning, power off/on to restart demo board again. All of test functions could be continued.
2. Hibernate mode.

This mode is for testing board current in hibernate, entering provisioning if there is no recognized Wi-Fi AP
and watch video stream via APP. Details are:

After power on, input ‘1’ makes the board enter into hibernate mode. You can measure the current via 5 V
power input connector. Typically, the current is about 20 pA.

When entering hibernate mode, any UART input wakes up the board and exits hibernate. Actually, UART
input is similar with GPIO trigger input. This mode is quite similar with some applications that only need
buttons or alarm inputs such as PIR input to wake up the system.

After waking up the board, it is ready to accept RTSP request. In this mode, you can run network stream
APP to watch. As shown in Figure 5-6, click ‘+’ to add a new address, input rtsp address and port. For
example, rtsp://192.168.0.103:554, choose UDP. Click ‘OK’(¥E) to open video stream.

Dol %l =  © w1129
EasyPlayer RTSP &

rtsp://192.168.0.103:554

ERARE B

rtsp://192.168.0.103:554

st (e @uop

EERRFFE:

(@) =

Figure 5-6. RTSP Configuration
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Note
If measure current is in hibernate mode, make sure to disconnect with the JTAG cable and unplug
the J1 jumper.

3. Intermittently Connected mode.

This mode is for the testing the board average current, which is intermittently sending status data to server
and enters into hibernate. It is also woken up by any input via UART and entering into ready to accept RTSP
request when it is in hibernate mode. Same as above, UART input is similar with the GPIO trigger input. This
mode it is quite similar with some applications that report status and heartbeat signal to remote servers with
long interval time. Details are:

a. After power on, input ‘2’ makes the board enter into intermittently connected mode.

b. Select video and which audio to use. It is preparing to play the video after wake-up from hibernate by the
UART input.

c. Input remote TCP server IP address such as 192.168.10.105.

d. Inputinterval time in second such as 10.

e. Board is woken up intermittently by RTC and sends 100 data to remote TCP sever again and again.

f.  Any UART input wakes up the board from hibernate to prepare accepting RTSP request mode.

g. UART tool Print:

Figure 5-7. UART Printing in Intermittently Mode
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h. Net assist tool Print:

Figure 5-8. Net Assist Receiver Printing in Intermittently Mode

In Net printing, a new connection is created every time. The connection is lost between sending data.

Note
TCP server must be opened before finished configuration. If don’t receive TCP data in server,
please try to close VPN or add net assist software in white list of firewall software.

4. Always Connected with Long Sleep/with IOT mode.

This mode is for testing board average current that is intermittently sending status data to the server and
entering into LPDS. In this mode, the network connection between the test board and the Wi-Fi AP is not
lost. It is also woken up by any input via UART when it is in LPDS. This mode it is quite similar with some
application that only report status and heartbeat signals to remote servers, and are able to respond to server
requests quickly because the connection socket is not lost in the remote server.

Note
IOT and Long Sleep mode need AP supporting.

18 TIDA-010224
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a. Details are:
i. After power on, input ‘3’ or ‘4’ will make board enter into Always Connected with Long Sleep or with
10T mode.
ii. Input beacon interval time to keep alive in AP connecting list.
iii. Select video and which audio from, it is preparing for play video after wake-up from hibernate by
UART input.
iv. Input remote server IP address, such as 192.168.10.105.
v. Inputinterval time of sending data in second, such as 10.
vi. Board will be woken up intermittently by RTC and send 100 data to remote TCP sever again and
again.
vii. Any UART input will wakeup board from hibernate to prepare accepting RTSP request mode.
b. UART tool print:

***ﬁ(ﬁﬁﬁﬁk**ks‘(ﬁﬁ*fe*ﬁs‘(ﬁﬁk***#k‘(ﬁ*s‘es‘eﬁstart Vz lﬁﬂ‘ﬁ*ﬁb’fﬁﬁs“ﬁ‘s‘e*s’(ﬁt{)‘(ﬁﬁfe*b‘(b’(fdﬁQ’ﬁ***ﬁ‘(ﬁﬁ)‘a

Startup Tick = 0 s: 0 ms.
the first start
#%% Cchoose demo working mode : #%*
1) for Hibernate.
2) for Intermittently Connected.
3) for Always Connected with Long Sleep
4) for Always connected with IOT mode
5) for measure Time of Ke¥ action
gl_aﬁe enter your use case selection:

[Event] STA connected to AP

BSSID:d0:c7:c0:4f:45:86

SSID:Peter

[Event] STA connected to AP

BSSID:d0:c7:c0:4f:45:86

SSiD:Peter
IPV4_ACQUIRED IP Acqu‘ired

IP=192.168.0.101 , Gateway=192.168.0.1
- 24 LSI -2 5 -
Please enter your LSI duration in milliseconds (min- 100 msec, max- 20000 msec): 100
IPV4_ACQUIRED IP Acquired

IP=192.168.0.101 , Gateway=192.168.0.1
IPVA_ACQUIRED IP Acquired

IP=192.168.0.101 , Gateway=192.168.0.1
IPV4_ACQUIRED IP Acquired

IP=192.168.0.101 , Gateway=192.168.0.1

select Audio source when transfer video stream

1) only video

2) Audio from inside ring data

3) Audio from micphone

Please select audio type:

Please input Destination IP address: xXx,XXX,XXX,XXX
192.168.0.105

Destination IP addrgss i5 & c0a80069
Please_enter your interval time in seconds
Interval Time is : 262154

starting AlwaysConnected_LSI mode
[Event] STA connected to AP
BSSID:d0:c7:c0:4f:45:86
SSID:Peter

IPV4_ACQUIRED IP Acquired
IP=192.168.0.101 , Gateway=192.168.0.1

Send Packet...

send Packet...

send Packet...

send Packet...

send Packet...

Figure 5-9. UART Printing in Always Connecting Mode
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c. Net assist tool print:

Figure 5-10. Net Assist Receiver Printing in Always Connecting Mode

In Net printing, A new connection is created firstly, and it isn’t lost between sending data.

Note
TCP server must be open before finished configuration. If you do not receive TCP data in your
server, try to close VPN or add net assist software in white list of firewall software.

5. Measure Time of Key action.

This mode is for testing the board startup time that is from exiting hibernate to sending out the 10 frames of
image. It is able to be woken up by any input via UART for testing. You can get the printing timestamp log via
UART or test the wave via J13.2 pin with oscilloscope. Details are:

a. After power on, input ‘5’ makes the board enter into Measure Time of Key action mode.
b. Input remote server IP address such as 192.168.10.105. Then test board enters into Hibernate.
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c. Any input via UART wakes up board and send data out to remote TCP server after getting the image
frame.

ﬁi{ﬂ'f{ﬁ'ﬂ#W*W&ﬂ*ﬁﬂwﬂﬂﬂﬁkﬁﬁ**ﬁﬁﬂﬁﬂﬂ'ﬂwﬁstart v2 1wa*ﬂw¢twwveaw«*wwawn&w#an—v«nnwwwuwna
-

startup Tick = 0 s: 0 ms.

[MeasureTimeTask] -- woken by GPIO and finished ¢€3235 initialize. Tick = 0 s: 12 ms.

[MeasureTimeTask] -- Power up ov. Tick =0 s: 20 ms.

[MeasureTimeTask] -- start ov configuration. Tick = 0 s: 151 ms.
[Event] STA connected to AP
BSSID:d0:c7:c0:47:45:86
SSID:Peter

IPV4_ACQUIRED IP Acquired
IP=192.168.0.101 , Gateway=192.168.0.1

[MeasureTimeTask] -- Get No.0 image size. datasize = 256 Tick = 433 ms.
[MeasureTimeTask] -- Get No.0 image data. Tick = 0 s: 447 ms.
[MeasureTimeTask] -- Get No.l image size. datasize = 40 Tick = 519 ms.
[MeasureTimeTask] -- Get No.l image data. Tick = 0 s: 533 ms.
[MeasureTimeTask] -- Get No.2 image size. datasize = 40 Tick = 557 ms.
[MeasureTimeTask] -- Get No.2 image data. Tick = 0 s: 571 ms.
[MeasureTimeTask] -- Get No.3 image size. datasize = 304 Tick = 640 ms.
[MeasureTimeTask] -- Get No.3 image data. Tick = 0 s: 654 ms.
[MeasureTimeTask] -- Get No.4 image size. datasize = 104 Tick = 695 ms.
[MeasureTimeTask] -- Get No.4 image data. Tick = 0 s: 709 ms.
[MeasureTimeTask] -- Get No.5 image size. datasize = 1240 Tick = 768 ms.
[MeasureTimeTask] -- Get No.5 image data. Tick = 0 s: 782 ms.
[MeasureTimeTask] -- Get No.6 image size. datasize = 3272 Tick = 850 ms.
[MeasureTimeTask] -- Get No.6 image data. Tick = 0 s: 865 ms.
[MeasureTimeTask] -- Get No.7 image size. datasize = 4096 Tick = 892 ms.
[MeasureTimeTask] -- Get No.7 image data. Tick = 0 s: 908 ms.
[MeasureTimeTask] -- Get No.8 image size. datasize = 2240 Tick = 931 ms.
[MeasureTimeTask] -- Get No.8 image data. Tick = 0 s: 946 ms.
[MeasureTimeTask] -- Get No.9 image size. datasize = 3456 Tick = 977 ms.
[MeasureTimeTask] -- Get No.9 image data. Tick = 0 s: 992 ms.
[MeasureTimeTask] -- Send out Page infor and Image data and eEntering HIB. Tick =1 s: 8 ms.

Figure 5-11. UART Printing in Measure Startup Mode
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Figure 5-12. Net Assist Receiver Printing in Measure Startup Mode
Note
The startup time is affected by WIFI connection time, especially in the first time running.
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